Legal Notices

This guide is copyrighted ©2007 by Digidesign, a division of Avid Technology, Inc. (hereafter “Digidesign”), with all rights reserved. Under copyright laws, this guide may not be duplicated in whole or in part without the written consent of Digidesign.

003, 003 Rack, 96 I/O, 96i I/O, 192 Digital I/O, 192 I/O, 888|24 I/O, 882|20 I/O, 1622 I/O, 24-Bit ADAT Bridge I/O, AudioSuite, Avid, Avid DNA, Avid Mojo, Avid Unity, Avid Unity ISIS, Avid Unity MediaNetwork, Avid Xpress, AVoption, AVoption|V10, Beat Detective, Bruno, Command|8, Control|24, D-Command, D-Control, D-Fi, D-fx, D-Show, DAE, Digi 002, Digi 002 Rack, DigiBase, DigiDelivery, Digidesign, Digidesign Audio Engine, Digidesign Intelligent Noise Reduction, Digidesign TDM Bus, DigiDrive, DigiRack, DigiTest, DigiTranslator, DINR, DV Toolkit, EditPack, Impact, Interplay, M-Audio, MachineControl, Maxim, Mbox, MediaComposer, MIDI I/O, MIX, MultiShell, OMF, OMF Interchange, PRE, ProControl, Pro Tools M-Powered, Pro Tools, Pro Tools|HD, Pro Tools LE, QuickPunch, Reel Tape, Reso, Reverb One, ReVibe, RTAS, Smack!, SoundReplacer, Sound Designer II, Strike, Structure, SYNC HD, SYNC I/O, Synchronous, TL Space, Velvet, and X-Form are trademarks or registered trademarks of Digidesign and/or Avid Technology, Inc. All other trademarks are the property of their respective owners.

Product features, specifications, system requirements, and availability are subject to change without notice.

PN 9106-58405-00 REV A 10/07

Comments or suggestions regarding our documentation? email: techpubs@digidesign.com

Warning

This product contains chemicals, including lead, known to the State of California to cause cancer and birth defects or other reproductive harm. Wash hands after handling.

Communications & Safety Regulation Information

Compliance Statement

The model 192 I/O complies with the following standards regulating interference and EMC:

- FCC Part 15 Class A
- EN55103 – 1, environment E4
- EN55103 – 2, environment E4
- AS/NZS 3548 Class A

Radio and Television Interference

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules.

Communications Statement

This equipment has been tested to comply with the limits for a Class A digital device. Changes or modifications to this 192 I/O not authorized by Digidesign, Inc., could void the Certification and negate your authority to operate the 192 I/O. This 192 I/O was tested for CISPR compliance under conditions that included the use of peripheral devices and shielded cables and connectors between system components. Digidesign recommends the use of shielded cables and connectors between system components to reduce the possibility of causing interference to radios, television sets, and other electronic devices.

Safety Statement

This equipment has been tested to comply with USA and Canadian safety certification in accordance with the specifications of UL Standards; UL1419 and Canadian CSA standard; CSA C22.2 No.1-M90. Digidesign Inc., has been authorized to apply the appropriate UL & CUL mark on its compliant equipment.
Important Safety Instructions

When using electric or electronic equipment, basic precautions should always be followed, including the following:

- Read all instructions before using this equipment.
- To avoid the risk of shock, keep this equipment away from rain water, and other moisture. Do not use this equipment if it is wet.
- The equipment should only be connected to the correct rating power supply as indicated on the 192 I/O.
- Do not attempt to service the equipment. There are no user-serviceable parts inside. Please refer all servicing to authorized Digidesign personnel.
- Any attempt to service the equipment will expose you to a risk of electric shock, and will void the manufacturer’s warranty.

Warning!

- HD audio interfaces need room at their sides to maintain proper air flow and cooling.
- Do not install these units into a rack or other enclosure that doesn’t leave room on either side for the unit fans.
- Do not block the sides of the units (where fans are), or disconnect the fan.
- If the units are racked up in a case, remove all lids, doors, or covers before operating the units.
- Failure to do so can result in the units overheating very quickly, which can permanently damage them.

Disposal of Waste Equipment by Users in the European Union

This symbol on the product or its packaging indicates that this product must not be disposed of with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing it over to a designated collection point for the recycling of waste electrical and electronic equipment. The separate collection and recycling of your waste equipment at the time of disposal will help conserve natural resources and ensure that it is recycled in a manner that protects human health and the environment. For more information about where you can drop off your waste equipment for recycling, please contact your local city recycling office or the dealer from whom you purchased the produ
## contents

**Chapter 1. Introduction to the 192 I/O** .................................................. 1  
  What’s Included ................................................................. 1  
  System Requirements ......................................................... 2  
  About This Guide ............................................................... 2  
  About www.digidesign.com .................................................. 3  

**Chapter 2. 192 I/O Overview** ......................................................... 5  
  192 I/O Front Panel ............................................................ 5  
  192 I/O Back Panel ............................................................ 7  
  Using Input and Output Trims ................................................ 11  

**Appendix A. Adding or Removing I/O Cards** ............................... 13  
  Installing an I/O Card ......................................................... 13  
  Removing an I/O Card ......................................................... 16  

**Appendix B. Pinout Diagrams for the DB-25 Connectors** ............. 19  
  Analog Output DB-25 .......................................................... 19  
  Analog Input (+4 dBu) DB-25 ................................................. 19  
  Analog Input (~10 dB(V)) DB-25 .......................................... 20  
  AES/EBU DB-25 ................................................................. 20  
  TDIF DB-25 ............................................................... 21  

**Appendix C. 192 I/O Calibration Mode Instructions** ................... 23  
  About Calibration .............................................................. 23  
  Calibrating the 192 I/O ....................................................... 24  

**Index** .............................................................................. 27
Introduction to the 192 I/O

The Digidesign 192 I/O™ 16-channel digital audio interface is for use in a Pro Tools|HD system and features 24-bit analog-to-digital (A/D) and digital-to-analog (D/A) converters. The 192 I/O supports sample rates of up to 192 kHz for superior dynamic range and low noise floor.

192 I/O Features

- 16 discrete channels of input and output, with 4-segment LED Meters to monitor input and output on each channel. Input and Output channels can include:
  - Eight channels of 24-bit D/A and A/D converters for superior analog input and output at sample rates of 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, and 192 kHz
  - Ten channels of 24-bit-supported AES/EBU I/O. Eight-channel AES/EBU I/O supports sample rates of up to 96 kHz on all channels, and of up to 192 kHz on four channels simultaneously. Two-channel AES-EBU I/O supports sample rates of up to 96 kHz.
  - Sixteen channels of Optical I/O, through two pairs of Lightpipe (ADAT) connectors; one pair of optical ports can be switched to two channels of optical S/PDIF I/O
  - Two 24-bit-capable S/PDIF I/O supporting sample rates of up to 96 kHz
  - Real-time sample rate conversion on inputs of eight channels of either AES/EBU, Optical, or TDIF.
  - External Clock input and output for synchronizing 192 I/O with external 1x Word Clock or 256x (Slave Clock) devices.
  - Legacy Port for Digidesign-qualified Pro Tools|24 MIX audio interfaces.
  - Optional addition of cards to expand analog or digital I/O.
  - Simultaneous use of multiple Pro Tools|HD audio interfaces to further expand system input and output. For more information see the Expanded Systems Guide.

What’s Included

- 192 I/O
- AC power cable
- DigiLink cable (1.5ft. [0.46m])
- BNC cable (1.5ft. [0.46m])
- Digidesign Registration Information Card
System Requirements

The Digidesign 192 I/O requires a Digidesign-qualified Pro Tools|HD system.

Compatibility Information

Digidesign can only assure compatibility and provide support for hardware and software it has tested and approved. For a list of Digidesign-qualified computers, operating systems, hard drives, and third-party devices, refer to the Digidesign Web site (www.digidesign.com).

About This Guide

This guide provides a hardware overview of the 192 I/O.

Complete instructions for connecting and configuring the 192 I/O for your Pro Tools|HD system are located in the Pro Tools|HD Getting Started Guide. For additional information about using Pro Tools software to route your interface inputs and outputs to Pro Tools inputs and outputs, see the Pro Tools Reference Guide.

Conventions Used in This Guide

Digidesign guides use the following conventions to indicate menu choices and key commands:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>File &gt; Save</td>
<td>Choose Save from the File menu</td>
</tr>
<tr>
<td>Control+N</td>
<td>Hold down the Control key and press the N key</td>
</tr>
<tr>
<td>Control-click</td>
<td>Hold down the Control key and click the mouse button</td>
</tr>
<tr>
<td>Right-click</td>
<td>Click with the right mouse button</td>
</tr>
</tbody>
</table>

The following symbols are used to highlight important information:

💡 User Tips are helpful hints for getting the most from your system.

⚠️ Important Notices include information that could affect your data or the performance of your system.

👩‍💻 Shortcuts show you useful keyboard or mouse shortcuts.

📝 Cross References point to related sections in this guide and other Digidesign guides.
About www.digidesign.com

The Digidesign website (www.digidesign.com) is your best source for information to help you get the most out of your Pro Tools system. The following are just a few of the services and features available.

Product Registration Register your purchase online. See the enclosed Digidesign Registration Information Card for instructions.

Support and Downloads Contact Digidesign Technical Support or Customer Service; download software updates and the latest online manuals; browse the Compatibility documents for system requirements; search the online Answerbase; join the worldwide Pro Tools community on the Digidesign User Conference.

Training and Education Become a certified Pro Tools Operator or Expert; study on your own using courses available online, or find out how you can learn in a classroom setting at a certified Pro Tools Training Center.

Products and Developers Learn about Digidesign products; download demo software; learn about our Development Partners and their plug-ins, applications, and hardware.

News and Events Get the latest news from Digidesign; sign up for a Pro Tools demo.

To learn more about these and other resources available from Digidesign, visit the Digidesign website (www.digidesign.com).
This chapter describes the front and back panel features of the 192 I/O.

See the Pro Tools|HD Getting Started Guide for complete system installation and configuration instructions. If you are adding the 192 I/O to an existing system, see the Expanded Systems Guide.

### 192 I/O Front Panel

#### Power Switch and LED Ring

This button turns the 192 I/O on and off.

The LED ring around the power button will light green to indicate that the unit has powered up successfully and is connected to an active Pro Tools|HD system. If the LED ring is orange, the unit has power, but the computer it is connected to is shut down.

#### Sample Rate

These LEDs display the current sample rate of the 192 I/O internal crystal oscillator: 44.1 kHz, 48 kHz, 88.2 kHz, 96 kHz, 176.4 kHz, or 192 kHz. The sample rate can be set in Pro Tools when you create a new session, or in the Hardware Setup or Playback Engine dialogs if no session is open.
**Loop Master LED**

The LOOP MASTER LED indicates which Pro Tools|HD audio interface is the master Pro Tools peripheral. The Loop Master LED will be continuously lit on the current Loop Master peripheral only, and unlit on all other peripherals. (Only one Pro Tools|HD I/O can be Loop Master at a time.) The Loop Master LED will always be lit with a single interface.

Loop Master defaults to the first Pro Tools|HD peripheral connected to the primary, or “core” Pro Tools|HD card. On Pro Tools|HD (for PCIe) this is the Accel Core card. On Pro Tools|HD (for PCI) this is the HD Core card.

**Sync Mode LEDs**

The SYNC MODE LEDs indicate the current Clock Source as set in Pro Tools.

**INT (Internal)** Indicates the 192 I/O sample clock is generated by its internal crystal oscillator, as determined by the session Sample Rate.

**DIG (Digital)** Indicates that an external AES/EBU, TDIF, Optical (ADAT), or S/PDIF device is providing system clock. If no valid clock source is detected, 192 I/O will switch to INT, the DIG LED will flash, and an error message will appear on-screen in Pro Tools.

If at least two channels are not assigned from the selected digital port in the Main page of the Hardware Setup dialog, or if no valid clock source is detected at this port, 192 I/O will switch to INT and the DIG LED will flash.

**LOOP (Loop Master)** Indicates that the 192 I/O is slaving to another Pro Tools|HD I/O through Loop Sync. You do not set LOOP mode anywhere in the software. This is done automatically when you choose another peripheral as LOOP MASTER.

**EXT (External)** Indicates that the 192 I/O is using the EXT CLOCK IN port for system synchronization.

External Clock input and output do not have to be at the Word clock rate. EXT CLOCK IN synchronization will typically be 1x the current session sample rate. However, for sample rates higher than 48 kHz, the 192 I/O will generate a choice of 1x or a base rate of 44.1 kHz or 48 kHz, depending upon the higher rate, as follows:

<table>
<thead>
<tr>
<th>Session Sample Rate</th>
<th>Word Clock Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>44.1 kHz</td>
<td>44.1 kHz (or 256x out)</td>
</tr>
<tr>
<td>48 kHz</td>
<td>48 kHz (or 256x out)</td>
</tr>
<tr>
<td>88.2 kHz</td>
<td>88.2 kHz 44.1 kHz</td>
</tr>
<tr>
<td>96 kHz</td>
<td>96 kHz 48 kHz</td>
</tr>
<tr>
<td>176.4 kHz</td>
<td>176.4 kHz 44.1 kHz</td>
</tr>
<tr>
<td>192 kHz</td>
<td>192 kHz 48 kHz</td>
</tr>
</tbody>
</table>

**Meters**

These four-segment LEDs indicate signal level for each of the sixteen channels. The top row of meters indicates input levels, and the bottom row shows output levels. These meters are calibrated at –42 dB, –18 dB, –6 dB, and 0 dB, respectively.

*Note that 0 dB is not to be confused with clipping; use the on-screen meters in Pro Tools to determine whether a signal is clipping. See the Pro Tools Reference Guide.*
192 I/O Back Panel

Although the 192 I/O is a 16-channel audio interface, it has up to 50 inputs and outputs available through its various back panel connectors.

Input and Output Cards

The 192 I/O features four bays for I/O cards. Bays 1–3 contain Analog In, Analog Out, and Digital I/O cards, respectively. The fourth bay is an expansion bay, for which you can purchase an additional audio card of your choice.

Installing an optional A/D, D/A, or D/D card provides even more I/O (up to a maximum possible 74 inputs and outputs). See Appendix A, “Adding or Removing I/O Cards.”

Analog Input

This section contains connectors for analog audio input with 24-bit, 192 kHz A/D converters. Input is provided through two discrete DB–25 connectors. You can connect sources at both operating levels and choose between them from within Pro Tools. The two inputs are:

**+4 dBu Balanced** Provides eight balanced input channels at +4 dBu nominal operating levels.

**–10 dB(V) Balanced** Provides eight balanced input channels at –10 dB(V) nominal operating levels.

For wiring information, see Appendix B, “Pinout Diagrams for the DB-25 Connectors.”

For each channel, you can select input level and Input Trim settings from within the Hardware Setup dialog. (For instructions, see the Pro Tools|HD Getting Started Guide.)
Input Trims

Two dedicated Input Trims per analog input channel provide further calibration options and flexibility. Depending on how you utilize the two DB–25 input ports, you can use the A and B trim settings for numerous applications. See “Input Trims” on page 11.

In addition, the soft-clip limiter function helps avoid digital clipping. See “Input Trims” on page 8, and “Soft Clip Limiting” on page 12.

Analog Output

This section contains a single DB–25 connector and Output Trims for eight channels of analog audio output. These balanced outputs operate at +4 dBu levels. See Appendix B, “Pinout Diagrams for the DB-25 Connectors.”

💡 For –10 dB(V) gear, a special DigiSnake cable (sold separately) is available. If you want to make your own cable, be sure to use in-line transformers or resistor networks to properly pad the +4 dBu output to –10 dB(V) levels.

Output Trims

The Output Trims below the DB–25 connector are used to individually calibrate each channel’s output level.

Two sets of Output Trims are provided for each channel allowing you to store a second set of headroom values. This allows you to match two different headroom values for either input connector. For more information, see “About Input Operating Levels” on page 11.

💡 Most consumer electronics operate at –10 dB(V) levels, and may not feature balanced inputs and outputs. You can connect –10 dB(V) signals to the –10 dB(V) inputs, but you will need to make sure that the negative terminals are not connected.

Digital I/O

This section contains connectors for eight channels each of AES/EBU I/O, TDIF I/O, and Optical (ADAT) I/O. Only one digital format can be used at a time.

AES/EBU DB–25 connectors for eight channels of AES/EBU input and output. Each of the paired channels is a balanced three-conductor signal, and supports 192 kHz sample rates in dual-wire mode. Dual-wire mode uses two of 192 I/O’s physical I/O channels of AES/EBU I/O to carry each single stream of 192 kHz audio. Therefore, only four simultaneous channels of AES/EBU I/O are available at 192 kHz.

TDIF DB–25 connectors for eight channels of TDIF input and output. Conforms to standard eight-channel TDIF pinouts.

For more information, see Appendix B, “Pinout Diagrams for the DB-25 Connectors.”

Optical (ADAT) Dedicated, eight-channel 24-bit capable Optical port. Using real-time sample rate conversion, these inputs will accept up to 48 kHz sample rates and convert them to a Pro Tools session running at up to 192 kHz. These outputs will only output at sample rates of up to 48 kHz. Unlike the Optical port located on the enclosure, this Optical (ADAT) port is not switchable to Optical S/PDIF.

The inputs on the Digital I/O Card feature real-time sample rate conversion. For example, you can stream audio with a sample rate of 44.1 kHz into a 96 kHz session.

For more information, see the Pro Tools|HD Getting Started Guide.
Enclosure Connectors

The right half of the back panel of 192 I/O features a set of non-removable connectors that are mounted to the enclosure.

These connectors feature two additional channels of AES/EBU I/O and another eight channels of Optical I/O. These ports appear on-screen in Pro Tools as AES/EBU [Encl], and Optical (ADAT) [Encl]. The reference to the enclosure [Encl] differentiates the chassis-mounted ports from the I/O of the same types on the Digital I/O Card.

Also mounted on the enclosure are two channels of S/PDIF I/O on RCA connectors, Loop Sync, External Clock, and ports for attaching the 192 I/O to Pro Tools|HD cards and other audio interfaces.

AES/EBU [Encl]

These are balanced, three-conductor XLR connectors that accept and output a stereo, 24-bit AES/EBU digital data stream. These two ports support up to 96 kHz sample rates. The enclosure ports do not support dual-wire mode (required for 176.4 kHz and higher sample rates), or provide real-time sample rate conversion (use the ports on the Digital I/O card for these features).

S/PDIF Stereo I/O

These are unbalanced, two-conductor RCA jacks that accept and output a stereo S/PDIF digital data stream. S/PDIF supports up to 24-bit audio, at sample rates up to 96 kHz.

Optical (ADAT) [Encl]

These are Optical ports that accept up to eight channels of Optical (ADAT) input and output, or two channels (stereo) optical S/PDIF input and output. Optical (ADAT) mode supports sample rates up to 48 kHz. In TOS-Link mode, supports two-channel Optical input and output at sample rates up to 96 kHz. This port does not feature real-time sample rate conversion.

About Lightpipe-Compatible Devices

Lightpipe is an industry standard, eight-channel optical digital audio connection created by Alesis. Lightpipe is found on many devices, including Optical (ADAT) decks, modular digital multitracks (MDMs), sound cards, A/D or D/A converters, and digital consoles.

LOOP SYNC In and Out

Loop Sync is a dedicated clock loop for synchronizing multiple Pro Tools|HD peripherals together (multiple audio interfaces, and/or a Digidesign SYNC I/O and one or more audio interfaces). Loop Sync uses a word clock signal based on sample rates of either 44.1 kHz or 48 kHz. As sample rate increases in the system, Loop Sync continues to operate at a base rate of 44.1 kHz or 48 kHz, depending upon the higher rate.

The Loop Sync In and Out ports are standard BNC connectors that output a 1x Loop Sync clock signal. Loop Sync should only be used to chain multiple Pro Tools|HD peripherals together.
**EXT. CLOCK In and Out**

The External Clock I/O ports are standard BNC connectors that receive and output a word clock signal. These ports can be used to synchronize the 192 I/O to any device that requires (or provides) word clock.

External Clock In and Out are configured by your choice for Clock Source in Pro Tools.

💡 Because crucial timing data is passed through the Loop Sync and Word Clock ports, you should use high-quality, 75-ohm RG–59 cables for making connections.

**AC Power**

This connector accepts a standard AC power cable. The 192 I/O is auto power-selecting (100V to 240V) and will automatically work with a standard modular cable to connect to AC power receptacles in any country.

**Primary DigiLink**

The Primary port is where the DigiLink cable connects a Pro Tools|HD card (or other audio interface) to the 192 I/O. The Primary DigiLink port sends and receives all 32 I/O channels. As the 192 I/O is a 16-channel only device, channels 17–32 are passed through to the Expansion or Legacy port.

**DigiLink Length Specifications**

There are five different lengths of DigiLink cables.

- 18” (0.46m), included with each interface
- 12’ (3.6m), included with each Pro Tools|HD card
- 25’ (7.62m)
- 50’ (15.25m), the maximum length supported for 192 kHz sessions (sold separately)
- 100’ (30.5m), the maximum length supported by 96 kHz sessions (sold separately)

💡 For more information about DigiLink cables, refer to the Digidesign Web site (www.digidesign.com).

**Expansion DigiLink**

The Expansion port lets you connect an additional Pro Tools|HD audio interface to the 192 I/O. The Expansion port passes channels 17–32 to the secondary, or expansion I/O.

**Legacy Port**

This port lets you connect MIX-series Digidesign audio interfaces to the 192 I/O. You can connect two eight-channel interfaces (such as the 888|24 or 882|20) or a single sixteen-channel interface (such as the 1622 I/O, or 24-bit ADAT Bridge I/O) for expanded input and output options, using their original cables.

When the Legacy port has been activated from within Pro Tools, your MIX-series I/O will appear as channels 17–32 in Pro Tools.

💡 For more information on using Expansion or Legacy audio interfaces, see the Pro Tools|HD Getting Started Guide, and the Expanded Systems Guide.
Legacy and Expansion Peripheral Port Limitations

Because both the Legacy port and the Expansion port use channels 17–32, you can only use one at a time.

The Legacy port is not available in any session in which the sample rate is set for higher than 48 kHz.

Accessory Port

This port is not supported.

Using Input and Output Trims

Input Trims

The Input Trims below the two DB–25 connectors on the Analog In card are used to store two different calibration settings (A and B) for each channel.

These two adjustable Input Trims are for precisely calibrating and switching between a choice of independently adjustable headroom settings for each channel. You can adjust each Input Trim by hand with a small screwdriver.

For example, you could use the A trims for the +4 dBu port, and use the B trims for −10. Or, use A and B to maintain two different trims for any signal input port (+4 dBu or −10 dB(V)).

If you are not using the −10 dB(V) input connector, the B trims can be used to store an alternate set of headroom values for the +4 dBu inputs. Once set, you can switch between the different trim headroom values for the same input level from within Pro Tools.

About Input Operating Levels

Check the owner’s manual for your mixer, power amplifier or effects processor to see if it operates more comfortably at line level, in which case consider setting the 192 I/O to operate at −10 dB(V) line levels and/or adjusting the Input Trims.

Consider the following when connecting a mixer:

♦ If your mixer cannot handle more than 1.5V (RMS) inputs at +4 dBu, then you should set the 192 I/O to operate at −10 dB(V) line level.
♦ If your mixer can handle up to 15.5V (RMS) inputs, or has pads or attenuators on its inputs, then you can use the +4 dBu setting on the 192 I/O.
♦ 192 I/O is calibrated for 18 dB headroom at the +4 dBu setting.

Most manuals contain device input specifications, including whether or not there are pads or attenuators. Consult the manufacturer’s documentation for your mixer or power amplifier for further information.

Selecting Analog Input Operating Levels

If you want to switch the input levels of the 192 I/O from +4 dBu to −10 dB(V), you can access these parameters on a channel-by-channel basis in the Hardware Setup dialog. For instructions, see the Pro Tools|HD Getting Started Guide.
**Soft Clip Limiting**

The 192 I/O provides an optional “soft” limiter for each input. The Soft Clip limiter can be used to attenuate incoming analog signals to provide extra protection from temporary clipping transients and digital distortion.

With Soft Clip enabled, 192 I/O supports an additional 4 dB of headroom by rounding off the top 4 dB to the clip point.

*For more information on Soft Clip Limiting and other 192 I/O settings, see the Pro Tools|HD Getting Started Guide.*

**Output Trims**

**18 dB and 20 dB Output Levels**

The 192 I/O has two Output Trims for each output signal. You can switch between these Output Trim levels from within Pro Tools.

- Output Trim A is factory calibrated for 18 dB headroom.
- Output Trim B is calibrated for 20 dB headroom.

*For more information, see Appendix C, “192 I/O Calibration Mode Instructions.”*

**Digital Format Settings and Sample Rate Conversion**

The 192 I/O lets you specify the digital format for input, and apply sample rate conversion.

**To configure digital formats and sample rate conversion:**

1. Launch Pro Tools.
2. Choose Setup > Hardware.
3. Click the Digital tab and select Input Format (AES/EBU, ADAT, or TDIF).
4. Enable real-time Sample Rate Conversion by selecting channel pairs (1–2, 3–4, 5–6, 7–8) in the SR Conversion box on the Digital tab.

*At session sample rates above 48 kHz, sample rate conversion for the TDIF and Optical (ADAT) inputs on the Digital I/O card is automatically enabled on all eight inputs of the selected format.*

For more information, see the Pro Tools|HD Getting Started Guide.
Appendix A: Adding or Removing I/O Cards

The 192 I/O comes with one available expansion bay on the back of the unit. This bay lets you add another 192 AD Card, 192 DA Card, or 192 Digital Card (all sold separately) to increase the amount of available I/O on the unit.

The expansion bay is the only bay that allows for another card. The other three bays are hard-wired for the appropriate card (the upper left bay houses a 192 AD card; the upper right, the 192 Digital card; and the lower left, the 192 DA card). See “Installing an I/O Card” on page 13.

<table>
<thead>
<tr>
<th>Bay Number</th>
<th>Card Allowed</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A/D</td>
</tr>
<tr>
<td>2</td>
<td>D/A</td>
</tr>
<tr>
<td>3</td>
<td>D/D</td>
</tr>
<tr>
<td>4</td>
<td>Any</td>
</tr>
</tbody>
</table>

⚠️ It is important that you follow the guidelines in this chapter to avoid damaging your 192 I/O or any of your I/O cards.

These factory-installed cards can be removed, if needed, for servicing, or to swap out cards in the fourth bay for different studio setups. If you remove a single card from the 192 I/O, the unit will continue to function while the audio card is being serviced. See “Removing an I/O Card” on page 16.

Installing an I/O Card

Installing an optional card in the expansion bay

To insert or replace a card:

1. Power off and disconnect the 192 I/O from your Pro Tools|HD system.

2. Make sure that the equipment is properly grounded.

3. Remove all 16 of the small Phillips-head screws around the edges of the top cover. Don’t lose the screws—put them in a safe place!

Removing the top cover screws
4 Lift off the top of the 192 I/O and set it aside.

5 Remove the five screws on the cover over the empty bay. Do not misplace these screws; note that they are a different size and shape from the top cover screws.

6 Look into the empty bay to locate the guide rails for the card to slide in on.

7 Slide the edges of the card into the guide rails on each side of the bay.

8 Gently push the card back into the bay, lifting slightly to keep components underneath the card from touching the back panel.

9 Attach the card’s faceplate onto the back panel surface of the 192 I/O with the same screws you removed from the empty bay cover.
10 Locate the raised ridge in the middle of the 50-pin cable which connects to the 192 I/O chassis. This ridge is only on one side of the connector, and there is a matching groove on only one side of the 50-pin connector on the card.

11 Gently push the cable connector into the card’s connector. The ridge on the cable connector must line directly into the groove on the card connector. Be very careful not to bend any of the pins or to over-stress the card.

12 Place the top cover onto the 192 I/O.

13 Replace the original screws.

14 Connect the 192 I/O to your Pro Tools|HD system.

15 Power on your 192 I/O.

16 When you power on the unit, the power LED should turn orange.

17 Start up the computer.

18 When you boot up the computer, the power ring should turn from orange to green.

   – or –

If it doesn’t, see “Troubleshooting” on page 16.

19 If the ring turns green, and the computer boots properly, launch Pro Tools.

20 Open the Hardware Setup dialog to confirm that the new card is recognized:

   • If you installed a 192 Digital card, you should see a new tab called Digital 9–16.
   • If you installed a 192 AD card, you should see a new tab called Analog In 9–16.
   • If you installed a 192 DA card, you should see a new tab called Analog Out 9–16.

21 If the new card does not appear in the Hardware Setup dialog, power down, check the seating of the card, and recheck the cables inside the 192 I/O.
Hardware Setup Changes After Adding a Card

The additional inputs and/or outputs provided by the new card will appear in the Hardware Setup dialog, with the same controls and parameters as for the original card of the same type.

For example, if you add an Analog Input card to the original three cards, a second Analog Input tab will appear in the Hardware Setup dialog. You can route these new inputs (which will in this case be called Analog Inputs 9–16) with the same controls and parameters as the factory-installed version of the card.

💡 Whenever a card is added or removed from an Pro Tools|HD I/O, the routing in the Hardware Setup dialog will revert to default assignments. If you have complex routing and or mirroring in place, please note the assignments and reassign the inputs and outputs after the new card has been properly identified.

Troubleshooting

If the power ring does not turn from orange to green when you boot the computer, make sure you reconnected the DigiLink cable to the Primary port on the back of the unit. If the DigiLink cable is securely fastened and the other end is plugged into an HD Core or Process card in a computer that is booted, you may have inadvertently disconnected another 50-pin cable when installing the card.

Removing an I/O Card

In the event of a problem with one of the cards in your 192 I/O, you can remove the card and send it to Digidesign for repair.

The modular nature of the Pro Tools|HD system allows you to simply return the specific card, instead of the entire 192 I/O. Your Pro Tools|HD system will continue to function while missing a single card. It will not function if more than one of the factory-installed cards is missing, or if the wrong card is in detected in any of the first three bays.

⚠️ Before handling any of the cards or internal components of 192 I/O, discharge any static electricity by touching the outer casing of the power supply.

To remove an I/O card from the 192 I/O:

1. Power off and disconnect the 192 I/O from your Pro Tools|HD system.
2. Make sure that the equipment is properly grounded.
3. Remove the top cover of the 192 I/O by extracting the 16 small Phillips-head screws around the edges of the top cover, and lift it off. Put the screws in a safe place.
4. Remove the five screws on the front plate of the card to be removed.
5. Gently pull the 50-pin connector off of the edge of the card.
Pull the card out by gripping the edges between your thumb and forefinger. Pull straight back, lifting very slightly to avoid contact between components on the underside of the card and the 192 I/O back panel faceplate.

⚠️ When you pull a card out, pay particular attention to keeping components on the surfaces of the card from bumping into any of the internal components or the back panel faceplate on the 192 I/O.

**Hardware Setup Changes After Removing a Card**

In this case, the Hardware Setup dialog will reflect the change by greying out the removed inputs and outputs, and reverting them to their default assignments. The remaining inputs and outputs will function normally.

For example, if you remove the Analog Input card, the Analog Input tab will disappear from the Hardware Setup dialog.

You will lose the configuration of any pairs of inputs or outputs that were assigned to the card being removed.
Appendix B: Pinout Diagrams for the DB-25 Connectors

Analog Output DB-25

Analog Input (+4 dBu) DB-25
### Analog Input (–10dB(V)) DB-25

- **CH1_HOT**
- **CH1_COLD**
- **CH1_GND**
- **CH2_HOT**
- **CH2_COLD**
- **CH2_GND**
- **CH3_HOT**
- **CH3_COLD**
- **CH3_GND**
- **CH4_HOT**
- **CH4_COLD**
- **CH4_GND**
- **CH5_HOT**
- **CH5_COLD**
- **CH5_GND**
- **CH6_HOT**
- **CH6_COLD**
- **CH6_GND**
- **CH7_HOT**
- **CH7_COLD**
- **CH7_GND**
- **CH8_HOT**
- **CH8_COLD**
- **CH8_GND**
- **NC_1**
- **MH1**
- **MH2**

### AES/EBU DB-25

<table>
<thead>
<tr>
<th>1-2 RCV</th>
<th>3-4 RCV</th>
<th>5-6 RCV</th>
<th>7-8 RCV</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH12_RCV_HOT</td>
<td>CH34_RCV_HOT</td>
<td>CH56_RCV_HOT</td>
<td>CH78_RCV_HOT</td>
</tr>
<tr>
<td>CH12_RCV_COLD</td>
<td>CH34_RCV_COLD</td>
<td>CH56_RCV_COLD</td>
<td>CH78_RCV_COLD</td>
</tr>
<tr>
<td>CH12_RCV_GND</td>
<td>CH34_RCV_GND</td>
<td>CH56_RCV_GND</td>
<td>CH78_RCV_GND</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1-2 XMT</th>
<th>3-4 XMT</th>
<th>5-6 XMT</th>
<th>7-8 XMT</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH12_XMT_HOT</td>
<td>CH34_XMT_HOT</td>
<td>CH56_XMT_HOT</td>
<td>CH78_XMT_HOT</td>
</tr>
<tr>
<td>CH12_XMT_COLD</td>
<td>CH34_XMT_COLD</td>
<td>CH56_XMT_COLD</td>
<td>CH78_XMT_COLD</td>
</tr>
<tr>
<td>CH12_XMT_GND</td>
<td>CH34_XMT_GND</td>
<td>CH56_XMT_GND</td>
<td>CH78_XMT_GND</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>NC_1</th>
<th>MH1</th>
<th>MH2</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>26</td>
<td>24</td>
</tr>
</tbody>
</table>

---

20 192 I/O Guide
Appendix B: Pinout Diagrams for the DB-25 Connectors

TDIF DB-25

<table>
<thead>
<tr>
<th>Pin Number</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-2</td>
<td>CH12_RCV_DATA</td>
</tr>
<tr>
<td></td>
<td>GND1</td>
</tr>
<tr>
<td>3-4</td>
<td>CH34_RCV_DATA</td>
</tr>
<tr>
<td></td>
<td>GND2</td>
</tr>
<tr>
<td>5-6</td>
<td>CH56_RCV_DATA</td>
</tr>
<tr>
<td></td>
<td>GND3</td>
</tr>
<tr>
<td>7-8</td>
<td>CH78_RCV_DATA</td>
</tr>
<tr>
<td></td>
<td>GND4</td>
</tr>
<tr>
<td>1-2</td>
<td>CH12_XMT_DATA</td>
</tr>
<tr>
<td></td>
<td>GND5</td>
</tr>
<tr>
<td>3-4</td>
<td>CH34_XMT_DATA</td>
</tr>
<tr>
<td></td>
<td>GND6</td>
</tr>
<tr>
<td>5-6</td>
<td>CH56_XMT_DATA</td>
</tr>
<tr>
<td></td>
<td>GND7</td>
</tr>
<tr>
<td>7-8</td>
<td>CH78_XMT_DATA</td>
</tr>
<tr>
<td></td>
<td>GND8</td>
</tr>
<tr>
<td>9</td>
<td>RCV_LRCK</td>
</tr>
<tr>
<td>8</td>
<td>RCV_EMPHASIS</td>
</tr>
<tr>
<td>5</td>
<td>RCV_FS1</td>
</tr>
<tr>
<td></td>
<td>RCV_FS0</td>
</tr>
<tr>
<td>7</td>
<td>XMT_LRCK</td>
</tr>
<tr>
<td>6</td>
<td>XMT_EMPHASIS</td>
</tr>
<tr>
<td></td>
<td>XMT_FS1</td>
</tr>
<tr>
<td></td>
<td>XMT_FS0</td>
</tr>
<tr>
<td>21</td>
<td>NC=</td>
</tr>
<tr>
<td>20</td>
<td>NC=</td>
</tr>
<tr>
<td>19</td>
<td>NC=</td>
</tr>
<tr>
<td>18</td>
<td>NC=</td>
</tr>
<tr>
<td>17</td>
<td>NC=</td>
</tr>
</tbody>
</table>

DB25F_RA_TDIF

GND_C

GND_A

FB30

FB31

22PF

22PF
Before you use the 192 I/O audio interface, you may want to calibrate its input and output levels to the level of your mixing console.

The 192 I/O has +4 dBu and –10 dB(V) inputs, and +4 dBu outputs, each with their own trim pots for proper calibration.

The 192 I/O is factory-calibrated so that its +4 dBu input operating level is set for 18 dB headroom above +4 dBu (maximum input/output +22 dBu).

If you need to recalibrate your 192 I/O or other components of your studio, you can use the alignment procedure described in this chapter.

**About Calibration**

Calibrating levels on a digital recording device is different from calibrating levels on an analog recording device. Unlike analog devices, most digital devices do not have a standard “0 VU” level setting that corresponds to nominal input and output levels. Instead, with an interface such as the 192 I/O, the meters are calibrated in *decibels below peak* or dBFS (dB full scale)—digital clipping level.

**Headroom**

The concept of headroom is slightly different for analog and digital devices.

**Analog** Most analog devices allow for a certain amount of headroom above 0 VU. If you send a signal above 0 VU to an analog recorder, you still have a margin of headroom, and if tape saturation occurs, it does so fairly gracefully, giving the audio a compressed sound that some find desirable.

**Digital** Digital devices, on the other hand, do not allow for signals that exceed the dynamic range of the input or dBFS (dB full scale). When a signal exceeds the maximum input level for a digital device, clipping occurs, causing digital distortion, which is harsh and usually undesirable.

**The Calibration Process**

**Analog** To calibrate the input level of an analog device to a mixing console’s output level, you would typically send a 1 kHz tone at 0 VU from the console to the analog deck and align the recording deck’s meters to read 0 VU.
**Digital** With a digital recording device such as the 192 I/O, in order to allow for headroom, you must align a 0 VU tone from the console to a value less than zero (or below dB full scale \([-x \text{ dBFS}]\)) on the 192 I/O, by exactly the amount of headroom that you want.

For example, to have 12 dB of headroom above 0 VU with the 192 I/O, you must align the incoming 0 VU 1kHz tone to a level of \(-12 \text{ dBFS}\). For 18 dB of headroom, you would align it to \(-18 \text{ dBFS}\). (Since it is assumed that you are using the 192 I/O with a +4 dBu device or console, a 0 VU signal level coming out of the device or console is actually equivalent to a nominal +4 dBu level signal.)

---

**Calibrating the 192 I/O**

To calibrate the 192 I/O you put Pro Tools in a special operating mode called *Calibration mode*, then use the Signal Generator plug-in to generate a test tone for alignment.

The Pro Tools installer includes a standard 8-channel calibration session for the 192 I/O. You can use this session as is and change the input and output assignments for more 192 I/O channels or use it as a base to make your own calibration template.

The following instructions show how the calibration session was created. You can create a session from scratch or open the calibration template and walk through these instructions.

⚠️ **Turn down your monitoring system before beginning calibration. The Signal Generator plug-in emits a continuous signal when inserted on a track.**

---

**To calibrate the 192 I/O Outputs:**

1. Launch Pro Tools and create a new session.
2. Choose Setup > Preferences and click Operation.
3. Enter the desired Calibration Reference Level value in dB. A level of \(-18 \text{ dB} \) is typical. (It is not necessary to type a minus sign here.)
4. Click OK.
5. Create a new mono audio track by choosing Track > New.
6. Insert the Signal Generator plug-in on the track.
7. Set the Signal Generator frequency to 1000 Hz. 1000 Hz is typical, but any frequency will work. Other typical values are 250 Hz and 500 Hz.
8. Set the Signal Generator signal waveform to Sine.
9. Set the Signal Generator output level. This should be the same value you entered as the Calibration Reference Level (such as \(-18 \text{ dB} \)).
10. Route the track’s output to Bus 1. In the calibration template, Bus 1 has been renamed to “1k Tone.”
11. Create a mono Auxiliary Input track for each 192 I/O output you want to calibrate. Set the output assignment for each of these Auxiliary Inputs to its respective I/O output.
12. Set the input of each Auxiliary Input track to Bus 1, or 1k Tone for the template session.
13 Create an additional mono Auxiliary Input track for each input you want to calibrate. Set the input assignment for each of these Auxiliary Inputs to its respective I/O input. Then set the output of each of these Auxiliary Inputs to an unused bus pair (for example Bus 3–4). In the template session the bus names are Null and Out. This makes sure feedback doesn’t occur when monitoring main outputs 1–2.

14 Connect an external VU meter to each of the I/O outputs in turn. (One at a time as you calibrate.)

15 Set all Pro Tools track faders to their default of 0 dB by Alt-Shift-clicking (Windows) or Option-Shift-clicking (Mac) any fader.

16 The trim pots are located at the back of the unit, underneath the DB-25 connector. The default trim assignment is “A.” If you wish to calibrate both the A and B trims, select the active trim in the Analog Output tab in the Hardware Setup dialog.

17 Adjust the I/O output level trim pot with a small, flat-head screwdriver to align the outputs to read “0 VU” on the external VU meter. We recommend using a tweaker tool with a recessed flat-head surrounded by a plastic tube to hold the trim pot. Tweakers can usually be found at electronic supply stores.

To calibrate the 192 I/O inputs:

1 Connect the 192 I/O outputs to a bank of 192 I/O inputs by doing either of the following:
  - Use a DB-25 to DB-25 straight through cable.
  - Interconnect the XLR ends of DB-25-to-XLR together.

2 In Pro Tools, select Options > Calibration Mode.

The names of all uncalibrated tracks begin to flash. In addition, the track volume indicator of each Auxiliary Input track receiving an external input signal now displays the reference level coming from the calibrated output (default is –18 dB).

3 Adjust the 192 I/O input level trim pots with the same small flat-head screwdriver or tweaker. It is best to calibrate the inputs with the back of the 192 I/O facing you and the Pro Tools screen well in sight. If you cannot see the Pro Tools screen, consider asking another person to assist you with the input calibration. When the level is properly matched, the track name will stop flashing and the peak volume indicator will indicate your headroom value (the default is “–18.0”).

The Automatch indicator arrows on each track show the direction of adjustment required for alignment:

- When the incoming level is higher than the reference level, the down arrow will appear lit (blue). In this case, trim the I/O input level down.
- When the incoming level is lower than the reference level the up arrow will appear lit (red). In this case, trim the I/O input level up.
When you have properly aligned the incoming peak signal levels to match the calibration reference level, both Automatch indicator arrows will light: the up arrow red and the down arrow blue.

Above the fader is a peak volume indicator. This indicator will show the dB level above and below your chosen headroom value. If the peak indicator is showing –19.1, you are –1.1 dB below a headroom value of –18 dB. If the display is showing –16.5, you are +1.5 dB above your headroom value of –18 dB.

When you have finished, deselect Options > Calibration Mode.

**Calibrating a System with Both 192 I/O and 96 I/O Audio Interfaces**

The “A” trim on the 192 I/O is factory preset with 18 dB of headroom in its +4 dB line level operating mode. The 96 I/O, however, is fixed at 14 dB of headroom and its inputs are not adjustable.

When setting up a 96 I/O (particularly in systems using a combination of the 192 I/O and 96 I/Os), it may make sense to calibrate all I/Os for –14 dB headroom. This helps ensure that recorded audio files have the same relative levels regardless of which interface is used for recording.
Symbols
+4 dBu 7, 8, 11

Numerics
–10 dBV 7, 8, 11
192 I/O
  Back Panel 7
  Front Panel 5
  Overview 5
96 I/O and level calibration 26

A
A/D converters 7
AC Power connector 10
Accessory Port 11
Adding I/O Cards 13
AES/EBU 8
  In/Out 9
Analog In
  card 7
Analog Input 7
  (+4 dBu) DB-25 19
  (+4 dBu) DB-25 Pinout Diagram 19
  (–10dBV) DB-25 20
  (–10dBV) DB-25 Pinout Diagram 20
analog monitoring 1
Analog Out
  card 7
Analog Output 8
  DB-25 Pinout Diagram 19
Analog Output DB-25 19

C
calibrate 24
calibrating the 888/24 I/O 24
calibration 11
Cards
  I/O 7
cards
  Analog In 7
  Analog Out 7
  Digital I/O 7
  removal 16
clipping 23
Clock Source 10
connecting a mixer 11

D
DB–25 connectors 7
DIG (Digital) mode 6
DigiLink 10
  cable 10
  Length Specifications 10
digital distortion 23
Digital Format
  settings 12
Digital I/O
  card 7
  connectors 8
Digital mode 6
Digital tab 12
Dual-wire mode 8
E
AES/EBU
AES/EBU 9
Enclosure
Optical (ADAT) 9
Connectors 9
Expansion
DigiLink 10
Peripheral Port Limitations 11
port 10
expansion bay 13
External Clock 10
I/O ports 10
In 6
port 6

H
Hardware Setup 5, 7
headroom 12
adjustable settings 11
settings 8
Soft Clip limiter and 12

I
I/O Cards
Adding or Removing 13
Input Cards 7
Input Levels 11
Input Trims 7, 11
inputs
calibrating 24
Internal clock mode 6
(INT) 6

L
LED ring 5
legacy
peripheral port limitations 11
port 10
Lightpipe
Optical port 9
line level 11

Loop
Master 6
Master LED 6
mode 6
Loop Master
LED 6
mode 6
Loop Sync 6
sample rates 9

M
Meters 6
MIX-series 10

O
Optical
(ADAT) 6
I/O 9
Optical (ADAT)
about Lightpipe-compatible devices 9
Output Cards 7
Output Levels 12
Output Trims 8, 12
outputs
calibrating 24

P
Pinout Diagrams 19
Playback Engine 5, 11
Power Switch
and LED ring 5
Primary
DigiLink 10
port 10

R
Removing an I/O Card 16
Removing I/O Cards 13
S
S/PDIF In/Out 9
Sample Rate 5
conversion 8
conversion, AES/EBU 12
conversion, Optical (ADAT) 12
conversion, TDIF and Optical (ADAT) 12
Session 6
Soft Clip limiter 12
and headroom 12
Sync Mode
    LEDs 6
synchronization 10

T
TDIF 8
TDIF DB-25 Pinout Diagram 21
TOS-Link
    Optical port and 9
Trims
    Input 8
    Output 8
Troubleshooting 16

W
word clock 6, 10